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От редакции 

Привет первым (и, надеюсь, не последним) читателям!  

Во-первых, хоть и поздновато, 
поздравляю всех с прошедшим Новым 
годом! 
Во-вторых, вот он - первый выпуск 
нашего журнала. FPS посвящен 
многим различным темам, но в первую 
очередь это журнал о разработке игр и 
обо всем, что имеет к этому 
отношение, прямое или косвенное. 
Программирование, графика, обзоры 
компьютерных и консольных игр, 
описания полезного бесплатного 

софта - обо всем этом Вы сможете 
прочесть на страницах FPS. Мы 
постарались, чтобы журнал был не 
просто интересным, но еще и 
полезным: чтобы каждый смог 
почерпнуть  из него  нужную 
информацию или чему-то научиться. 
Поэтому выпуски обязательно будут 
включать уроки на разные темы.  
 
Приятного чтения! 
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CreatureCreator 

Наш сегодняшний хит-парад открывает 
оригинальная  и уникальная в своем роде 
программа CreatureCreator. Многие часто 
сталкиваются с определенными трудностями 
при создании моделей людей и прочих 
персонажей. И CreatureCreator предназначена 
в первую очередь для них.  

Принцип таков: вы постепенно создаете 
персонаж, выбирая внешний вид всех частей 
тела, от головы до конечностей. Изменить 
можно все: глаза, форму черепа, уши, рот, 
нос, кисти рук, пропорции тела и т.д. Для 
каждой из частей есть внушительных 
размеров список возможных вариантов, 
сгруппированных по темам (фэнтези, демон, 
киборг, мужчина, женщина, манга и др.), так 

что выбирать есть из чего. Присутствует 
также возможность изменять размеры частей 
тела, что позволяет создавать абсолютно 
уникальных существ.  

Готовую модель можно экспортировать в 
формате 3DS или DXF. Можно также 
сохранить ее в проекте, чтобы вернуться к 
ней позже.  

Из недостатков стоит, пожалуй, отметить 
отсутствие генерации карты UV, но, 
несомненно, это вы и сами сможете сделать в 
других программах. 

 
Скачать CreatureCreator вы можете на 

сайте www.gamesanatomy.ru  
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ELEFONT 

Следующая программа довольно-таки 
известна, я думаю в силу ее простоты и 
оригинальности. ELEFONT предназначена для 
генерации трехмерных моделей на основе 
простого текста. То есть, вы пишете пару 
слов, выбираете TrueType шрифт и 
сохраняете получившееся. 

Интерфейс удобен и красиво оформлен. 
Недостаток у ELEFONT только один. А точнее 
два — экспорт поддерживает только два 
формата: DXF и INC. Первый предрасположен 
к известному редактору ландшафтов Bryce. 

 
Скачать ELEFONT можно на сайте ее 

разработчика: www.armanisoft.ch 

LODka 

 А этот редактор от нашего отечественного 
разработчика. Удобный низкополигональный 
моделлер, имеет много функций для работы с 
вершинами, полигонами и мешами, 
поддерживает текстурирование, материалы, 
скелетную анимацию, включает множество 
готовых примитивов, лайтмэппер и даже 
встроенный физический движок. Стоит также 
отметить расширяемость (можно скачивать и 
устанавливать плагины) и изменяемость 
(иконки кнопок можно перерисовать по 
своему вкусу). Поддерживает много форматов 
(OBJ, WRL, 3DS, MS3D, SMD, LWO, B3D, MD2).  

 
Скачать LODka можно на официальном 

сайте: lodka3d.narod.ru Там же можно найти 
плагины, уроки, разные библиотеки для 

GLScene и прочее. 
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MED 

Парадоксально, но этот редактор не 
забывают даже в наш век 3DS Max’ов и иже с 
ними. Старая бесплатная версия Conitec MED 
поставлялась с 3D Game Studio A5, еще черт 
знает когда. Однако это отнюдь не значит, 
что программа устарела. MED 4 отлично 
справляется со своими обязанностями: 
низкополигональным моделированием, 
созданием скинов и вертексной анимации, и 
экспортом в популярный формат MD2. Помимо 
этого, поддерживает 3DS и несколько других 
малоизвестных форматов. 

 
Скачать MED можно здесь: 
http://www.sendspace.com/file/28qs2d  

Plant Studio 

Очень интересный генератор растений и 
растительных оъектов. Имеется удобный 
мастер, где шаг за шагом вам объяснят, как 
создать растение, поддержка анимации и 
экспорта, как изображений-рендеров, так и 
трехмерных моделей в форматах 3DS, LWO, 
OBJ, DXF, INC и WRL. Есть также возможность 
сохранять растения в библиотеки — с 
программой поставляется целая коллекция 
таких.  

 
Скачать Plant Studio можно на сайте  
www.kurtz-fernhout.com 
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Anim8tor 

Очень популярный трехмерный редактор. 
По существу, это целая студия 3D-графики: 
здесь можно моделировать, создавать 
анимированных персонажей, и рендерить 
настоящие мультфильмы. И все это вмещается 
в менее чем полтора мегабайта!  

Присутствуют все нужные инструменты 
моделирования, создания материалов и 
анимации. Anim8tor поддерживает форматы 
3DS, LWO, OBJ, VTX, C, а ее собственный 
формат AN8 уже поддерживается многими 
средами трехмерной графики. 

 
Вы можете скачать Anim8tor на ее 

официальном сайте: www.anim8tor.com 

Crossroads 

 Crossroads полностью оправдывает свое 
название. Это действительно «перекресток», 
где сходятся пути 3D моделей, а точнее одни 
модели становятся другими. Crossroads 
обеспечивает полный импорт 3DS, DXF, POV, 
INC, RAW, COB, WRL, OBJ, NFF и экспорт 3DS, 
T3D, B3D, DXF, C, SMPL, X, POV, RAW, COB, 
WRL, OBJ, NFF. Больше ничего программа не 
умеет, даже вьювер из нее никакой, но с 
обязанностью конвертера справляется 
превосходно.  

 
Скачать актуальную версию Crossroads 

можно по следующей ссылке:  
http://www.europa.com/~keithr/crossroads/
download.html 
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DAZ|Studio 

Одна из наиболее популярных бесплатных 
программ для рендеринга. Ориентирована на 
импорт из Poser, так что в совместном 
использовании они дают полноценную 
трехмерную студию для профессионалов. 

Имеет полный набор стандартных функций 
для создания сцен из отдельных моделей, 
поддерживает импорт BHV, многочисленных 
форматов Poser и объектов Wavefront (OBJ и 
OBZ). Экспортирует сцены в BHV, DAE, OBJ и 
U3D.  

 
Скачать (ок. 20 Мб) можно на 

официальном сайте: www.daz3d.com 

UVMapper 

 Небольшая, но весьма полезная утилита. 
Позволяет работать с важной составляющей 
любой модели — картой UV-координат, 
которая определяет, какие части текстуры на 
какие полигоны лягут. UVMapper просто 
незаменима для тех, кто моделирует для 
трехмерных игр. 

Вы можете создавать развертки по 
нескольким методам (плоскость, куб, 
цилиндр, сфера), как для целой модели, так и 
для любых ее частей, вплоть до отдельного 
полигона. Можно двигать  полигоны и группы 
полигонов, расставляя их как можно более 
экономно, изменять их размеры на карте. 
Возможности воистину безграничны. 

Правда, UVMapper имеет один недостаток 
— поддержку только формата OBJ. Но для 
меня, например, это терпимо. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Скачать можно здесь: www.uvmapper.com 
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Обзор подготовил: 
 Gecko clocktower89@mail.ru 

Blender 

Можно с уверенностью сказать, что 
Blender — наиболее мощный 3D-инструмент 
из всех бесплатных. По своим возможностям 
эта программа ни в чем не уступает 
коммерческим аналогам, а в чем-то даже 
превосходит. Здесь есть все: абсолютный 
контроль над моделями вплоть до отдельных 
вершин, любые инструменты моделирования, 
включая инструменты скульптурного уровня, 
все возможные и невозможные средства 
материальности и визуального представления 
сцен, встроенный движок физики для 
твердых, мягких и даже жидких тел, 
профессиональная система рендеринга 
изображений и видео, поддержка Python 
Script и всего, что из этого следует (читай: 
неограниченные возможности)... Но при этом 
остается известная «хардкорность» Блендера, 
делающая его программой не для новичков. 

Освоится в нем непросто, но это стоит того. 
Скачать Blender можно на официальном 

сайте Blender Foundation: www.blender.org 
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Spyro the Dragon 
  J  a  v  a    -    и  г  р  а 

Познакомьтесь со Спиро — маленьким фиолетовым 
драконом. Но, я думаю, многие уже знакомы с ним по 
незабываемой трилогии его приключений на PlayStation. 
Эта серия игр по праву считается одной из лучших за 
всю историю трехмерных платформеров, а сам Спиро — 
несомненно, самый симпатичный из всех аркадных 
персонажей. 

Как и все драконы, Спиро неплохо умеет дышать 
огнем, что позволяет ему успешно справлятся с 
многочисленными грозными противниками, намного 
превосходящими его по размерам, а также бодаться 
своими рогами и немного летать. Все это, а еще много 
чего другого вам вместе со Спиро предстоит проделывать 
на 7 уровнях новой игры для мобильного от известного 
Java-разработчика Kaolink. 

Итак, на Королевство Драконов напал 
могущественный волшебник, заколдовавший 
всех до единого драконов. Спиро, разумеется, 
спасся от этой незавидной участи, но его ждет 
нелегкая задача: освободить всех драконов из 
плена, заодно расправившись с коварным 
волшебником.  

Вас ждет незабываемое путешествие по 
Королевству. Спиро побывает в руинах 
древних городов, в джунглях и таинственных 
заснеженных скалах. Все эти места населены 
хищными тварями, но одолеть их не составит 
большого труда. В этой игре Спиро научится 
использовать приемы kata — особого метода 

борьбы ,  ко гда 
и г р о к  м о ж е т 
п е р е к л ю ч а т ь с я 
м е ж д у  т р е м я 
разными типами 
а таки .  Разные 
приемы действенны 
против  разных 
типов противников. 
Повышать уровень 
k a t a  м о ж н о , 
с о б и р а я 
д р а г о ц е н н ы е 
камни. Также время 

от времени понадобиться искать особые 

ключи, открывающие двери, которые 
блокируют проходы на разные места уровней. 

Однако, кроме врагов, уровни игры таят в 
себе другую особенность: у каждого уровня 
есть два измерения — светлое и темное. 
Темное измерение таит немало опасностей и не 
меньше бонусов. Спиро может переходить 
между измерениями посредством специальных 
платформ. Вам придется решить немало 
головоломок, напрямую связанных с 
особенностями того или иного измерения. 

Уровень считается пройденным, как только 
вы освободите всех заточенных на нем 
драконов. После 
этого вам нужно 
т о л ь к о  н а й ти 
в ы х о д  —  и 
п ер ех од и т ь  к 
следующему этапу 
п р и к л ю ч е н и й . 
Кстати, уровни 
м о г у т  б ы т ь 
пройдены заново. 
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 В конце игры дракончика ждет финальная 
схватка с волшебником, где от вас 
потребуется все умение и все изученные 
приемы. Бой будет поделен на четыре 
«раунда», в каждом из которых злодея 
необходимо столкнуть на платформу 
перехода, после чего идет сражение в другом 
измерении. Помните, что в темном измерении 
на волшебника некоторые атаки не 

действуют. То же 
самое ,  кстати , 
относится и ко всем 
врагам из теневого 
измерения. 
По части графики 
м о б и л ь н ы е 
приключения Спиро 
з а с л у ж и в а ю т 
всяческих похвал. 
Р а з р а б о т ч и к и 
о т л и ч н о 
п о с т а р а л и с ь , 
перенося игру из 3D 

в двумерную технологию. Качественные 
пиксельартовые спрайты Спиро и других 

персонажей очень здорово смотрятся на фоне 
живописных рисованных ландшафтов. 
Уделено внимание мелким деталям, анимация 
так же вышла на ура. Игра идет в высоком 
разрешении, что, разумеется, только на 
пользу. 

А вот звук, в отличие от визуального 
исполнения, подкачал. Только вначале игры 
звучит короткая midi-мелодия, но в 
д а л ь н е й ш е м 
никаких звуков в 
игре  вы  не 
у с л ы ш и т е . 
Н е м н о г о 
разочаровывает 
— фанаты Спиро 
п р и в ы к л и 
н а с л а ж д а т ь с я 
о т м е н н о й 
музыкой вкупе с 
качественными 
з в у к о в ы м и 
эффектами  и 
о з в у ч к о й 
персонажей.  

Хотя, может, оно и к лучшему: большинство 
телефонов обладают крайне неприятным 
качеством звучания потоковых форматов. К 
тому же, большинство пользователей 
преимущественно по той же причине 
предпочитают отключать звук в игре, даже 
если он есть. 

Теперь о недостатках. Недостатков у Spyro 
the Dragon немного, а человек, впервые 
познакомившийся со Спиро по этой игре, так 

в о о б щ е  н е 
сочтет их за 
недостатки. Во-
первых, очень 
н е  х в а т а е т 
н е и з м е н н о г о 
к о м п а н ь о н а 
С п и р о  - 
с т р е к о з ы 
Спаркса, что не 
м о ж е т  н е 
сказаться на 
геймплее. Все 
вы помните, как 
з д о р о в о 

придумали ребята из Insomniac Games: 
уровень защиты дракончика показывает цвет 
Спаркса, а повышать его можно, время от 
времени прикармливая стрекозу бабочками. 
Здесь ничего подобного нет. Во-вторых, 
вызывают улыбку некоторые недочеты: 
отсутствие некоторых нужных эффектов, равно 
как и приемов Спиро, памятных нам по играм 
на PSX (полет, плавание, удар в прыжке), 
несоответствие внешних видов корзин и 
сундуков с теми, что в играх на PSX. Также 
стоило бы отметить линейность прохождения 
(нет домашнего уровня), но это скорее всего не 
недостаток, а особенность жанра. 

 
А  в  целом  Spyro the Dragon -  одна  из 

лучших java-игр, в которые я играл. Фанатам 
приключений  Спиро,  равно  как  и  всем 
остальным - однозначно must have! :) 

 
 
 
По  Королевству Драконов путешествовал: 

Gecko clocktower89@mail.ru 
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 GAME MAKER & XTREME3D 
э к с т р е м а л ь н ы е      в п е ч а т л е н и я 

Без сомнения, все мы мечтали создавать 
трехмерные игры. Для многих эта мечта 
стала реальностью, для многих — нет, но в 
любом случае речь пойдет о том, мимо чего 
пройти просто невозможно любому. 

В наш век неустанно развивающихся 
технологий, когда уже физически нельзя 
угнаться за всем, что появляется на арене 
игровой индустрии, так трудно найти что-то 
реально оправдывающее свою цену. 
Особенно это касается мира freeware, где 
понятие «передовые технологии» давно 
позабыто и редко вспоминается. В 
коммерческой среде всегда пожалуйста — 
вот тебе Dark Basic, вот 3D Game Studio A7, 
а вот недавно вышел FPS Creator X10 с 
поддержкой наиболее продвинутого API 
DirectX 10. А нам, приверженцам халявы, 
остается лишь искать, искать, и еще раз 
искать... И, представьте себе, иногда 
удается найти. Как, например, в случае с 
Xtreme3D — наиболее популярной 
библиотекой трехмерной графики для 

наиболее популярного конструктора игр 
Game Maker.  

Не помню толком, когда я впервые 
узнал о Xtreme3D. Но хорошо помню день, 
когда скачал и протестировал (то была уже 
версия 2). Признаться, зрелище 
впечатлило... Но не буду субъективным, 
поэтому пойду по порядку. 

Xtreme3D основан на OpenGL. С одной 
стороны, это хорошо, а с другой — не 
очень. Ведь Microsoft, операционными 
системами которой пользуется более 90% 
всех владельцев ПК, поддерживает OpenGL 
далеко не в той мере, как свой 
собственный API DirectX. Поэтому остается 
вероятность, хоть и небольшая, что игры, 
построенные на Xtreme3D, работать будут 
не у всех.  

Xtreme3D для полного раскрытия своих 
возможностей требует сравнительно 
мощной видеокарты. Но даже владельцы 
интегрированного графического ускорителя 
не будут разочарованы. 

      Xtreme3D V2, о котором пойдет речь, 
поставляется с коллекцией примеров, 
демонстрирующих его возможности, так что 
проблем с тестированием, думаю, ни у кого не 
возникнет. 
      Итак, основные «козыри» Xtreme3D против 
других движков это: 
• Поддержка большого количества 3D 
форматов (3DS, OBJ, MD2, MD3, SMD, B3D и 
др.) 

• Встроенные средства для создания 
динамичного неба, реалтаймовой воды, 
теней, генерации деревьев и т.д. 

• Поддержка шейдеров (это-то и требует 
наличия видеокарты помощнее), включая 
normalmapping, multimaterial и outline 

• Поддержка загрузки ресурсов из сжатого 
PAK-архива 

• Встроенная физика с использованием ODE 
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И, поверьте, это еще далеко не все. 
Поддержка карт освещения (lightmaps), 
технологии quadtree и octree для отбора 
видимости и проверки столкновений, 
статичные и динамичные cubemaps, 
возможность использовать несколько окон 
вида и библиотек материалов, встроенные 
эффекты motionblur и lensflare, собственная 
система частиц, множество опций и 
настроек для камеры, материалов и 
источников света - все это полностью 
доступно в Xtreme3D. Прибавьте к этому 
готовую IDE в виде скриптов и констант с 
удобоваримыми  названиями  плюс 
двенадцать примеров, демонстрирующих 
если не все, то почти все, и вы получите 
отличнейший движок, полностью готовый к 
работе, как говорится, из коробки.  

Единственное, что меня не устраивает, 
так это отсутствие в дистрибутиве 
подробной документации. Наличествовал 
лишь неудобный documentation.rtf со 
списком всех функций и краткими 
комментариями примерно к трети из них. 
Именно поэтому (здесь читателя придется 
немного разочаровать) знакомство с Xtreme 
3D, особенно на первых порах, у многих 
вызовет противоречивые эмоции. Просто 
так X3D свои секреты не откроет, придется 
попотеть, прежде чем выяснить, как именно 
работает та или иная функция. Кроме того, 
в определенных ситуациях различные 
объекты и режимы могут не на шутку 
конфликтовать, ибо, при всех его 
достоинствах, до абсолютной стабильности 
Xtreme3D еще далеко.  

Нельзя так же не отметить абсолютную 
несовместимость со стандартными 
графическими средствами GM. То есть, вам 
придется самим придумывать, как, 
напрмер, сделать шкалу здоровья или 2D-
анимацию. Все это, конечно, достижимо, но 
о старых способах можно забыть. Я бы 
с к а з а л ,  ч т о  д л я  у с п е ш н о г о 
программирования  на  X t reme3D 
необходимо не просто в совершенстве 
знать GML, но и обладать творческим, 
креативным мышлением и, естественно, 
недюжинным терпением. Терпение и труд 
все перетрут, господа! 

А теперь о приятном. Официальный 
дистрибутив X3DV2 со всеми нужными 
библиотеками, примерами и утилитой для 
создания PAK-архивов не обременяется 
никаким лицензионным соглашением и 
весит около семи с половиной мегабайт. 
Последнее, впрочем, для некоторых не 
самое приятное известие. Но коммерческие 
движки обычно весят намного больше, 
поэтому жаловаться не на что. 

Скачать Xtreme3D V2 можно на сайте 
его разработчика, Xception (который, 
кстати, является автором и других 
трехмерных библиотек для GM, таких как 
GM  I r r l i c h t  и  MoCo ) :  h t t p : / /
home.tiscalinet.de/xception/. 

В следующей части обзора движков 
пойдет речь о главном конкуренте Xtre-
me3D — Ultimate3D. 

Gecko 
clocktower89@mail.ru 
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PhotoFiltre - это очень удобный бесплатный графический редактор, содержащий 
все  необходимые  инструменты  как  для  ретуши  фотографий,  так  и  для  создания 
разнообразной  графики.  Скачать  PhotoFiltre  (а  также  скачать  плагины  и  разные 
утилиты) вы можете на официальном сайте: www.photofiltre.com. 

Просьба не путать PhotoFiltre с его коммерческим "старшим братом" - PhotoFiltre 
Studio.  Хотя  этот  редактор  гораздо  мощнее  и  функциональнее,  из-за  моей 
приверженности к freeware я не буду упоминать его в этих уроках. Советую и вам 
пользоваться по возможности только бесплатным софтом и не слишком поддерживать 
пиратство. Помните, что используя креки и т.п., Вы нарушаете закон. 

Урок PhotoFiltre.  
Текстуры поверхностей 

Сейчас мы попробуем сделать в PhotoFiltre 
пару текстур. 
 
Ржавчина. 
1.Мой "фирменный" алгоритм создания имитации 
ржавой поверхности металла. Для начала 
создадим документ и зальем все серым #333333. 
 
2.Теперь выберем инструмент Spray tool (спрей) 
и нанесем несколько разноцветных слоев 
напыления. Я использовал цвета #000000, 
#993300, #969696. 
 
 
3 . Т е п е р ь  с д е л а е м  т а к :  выб е р и т е 
Filter>Artistic>Watercolor>Method 2. 
 
 
4.Уже на что-то похоже! Но это еще не все: 
нажмите на панели инструментов кнопочку Dust 
reduction , чтобы убрать нежелательные точки и 
прочий мусор. Для полного счастья можно 
применить Filter>Texture>Zebra skin и нажать 
Ctrl+K для усиления эффекта. 

     
    1 
 
 
 
 
                               2 
 
 
 
 
    3 
 
 
 
 
                               4 
     



FPS #1                                          _     ____PhotoFiltre       __                                        page 14 

В PhotoFiltre встроена поддержка 
пл а гин ов ,  к о т о рые  т а кже 
называются модулями (modules). 
Плагины существенно расширяют 
возможности редактора. Например, 
есть плагины для автоматической 
коррекции эффекта «красных 
глаз», работы с каналами RGB, 
импорта и экспорта различных 
форматов изображений, получения 
интересных эффектов вроде шума 
или оптической деформации. 
Плагины представляют собой 
файлы с расширением PFL, 
которые необходимо кидать в 
директорию Plugins в папке с 
установленной PhotoFiltre. Со 
с л е д у ю щ и м  з а п у с к о м 
установленные плагины будут 
задействованы и доступны через 
контекстные меню. А чтобы 
вывести кнопки плагинов на 
отдельную панель инструментов, 

зайдите в настройки: Tools > Pref-
erences и на вкладке Plug-ins bar 
выделите галочками плагины, 
которые хотите видеть на панели. 
И н ф о р м а ц и ю  о б о  в с е х 
установленных плагинах можно 
увидеть через меню ? > About plug-
in. 
Скачать плагины можно на  
www.photofiltre.com/plugins.  

 
 

Дерево. 
Способов воссоздания деревянной поверхности 
существует очень много. Приведу здесь один, 
который я вывел специально для PhotoFiltre.  
 
1.Создаем документ и заливаем его коричневым 
#993300. 
 
2.Теперь выбираем Filter>Noise>Add noise, 
выставляем Amount равный 100. Нажимаем ОК. 
Усиливаем эффект шума комбинацией Ctrl+K. 
 
3.Выбираем  Filter>Visual Effect>Motion 
blur>Vertical. 
 
4.Поработаем с контрастом, цветностью и др. (на 
панели инструментов - кнопки brightness, 
contrast, saturation, gamma) и готов результат! 
Как видите, предельно просто, не нужно даже 
ничего рисовать. 
 
Успехов Вам в творческой работе! 
 

Gecko 

 
     

    1 
 
 
 
 
                               2 
 
 
 
 
    3 
 
 
 
 
                               4 
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Harry Potter and the Sorcerer’s Stone 
для Sony PlayStation I 

"Это ошибка! Я не маг, я всего лишь Гарри Поттер..." 
"Гарри Поттер и филосовский камень" 

 
та игра как вы, наверно, догадались сделана по мотивам фильма про 
Гарри Поттера, а именно "Гарри Поттер и философский камень". Она 
довольно прославилась, а именно из-за своего интересного народу 
главного персонажа. Гарри Поттер уже издавна завоевал сердца 
многих детей, которые с удовольствием читали сказочные фэнтези-
книги про него. Затем вышел фильм, о первой книге, который так и 
назывался "Гарри Поттер и филосовский камень". Что интересно при 
разработке фильма название часто менялось, например: "Гарри 
Поттер и камень мага", и.т.д. Ну а потом вышел еще и второй фильм, 

затем третий. Создатели так и хотели снимать фильмы по всем семи книгам, которые 
должна написать Джоан Роулинг, создательница самого Гарри, но не смогли. Итак, 
представляем вам заключительный фильм о Гарри Поттере: "Гарри Поттер и Орден 
феникса". Такой неожиданный поворот был вызван по многим причинам. Во первых это 
из-за того что молодая актриса Эмма Уотсон, играющая в фильме Гермиону Грейнджер 
решила уйти из фильма. По ее словам она не хочет зацикливаться на одной роли и хочет 
попробовать себя в других ролях. К сожалению, даже деньгами не удалось изменить ее 
решения. Ну и, конечно, это связано с возрастом актеров. Время неизбежно летит и все 
актеры взрослеют. И тот маленький мальчик Даниел Рэдклифф, который играл в фильме 
Гарри Поттера, давно уже не маленький, а уже взрослый подросток. Ну теперь можно 
только с хорошими воспоминаниями вспоминать замечательные фильмы, сделанные 
Warner Bros. Хотя последние две части были сделаны исключительно из-за больших 
денег. Если первые три части были душевные, сделанные на благо зрителям, то 
последние части пытаются нажиться на раскрученной серии фильмов с популярнейшим 
сказочным персонажем. И вправду, Гарри Поттер вскрутил голову юным жителям 
планеты. Он в свое время был просто супер-темой для увлечения. Это как в свое время 
покемоны и "Властелин колец". Но, я уже слишком много вам рассказал и поэтому хочу 
тут остановится и рассказать-таки про эту замечательную игру на PSX: Harry Potter and 
the Sorcerer's Stone. 
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Сюжет игры вам будет вкратце рассказываться в самой игре. И не только в самом 
начале. Периодически, через какое-то время вам будут рассказываться отрывки из 
книги. Сюжет примерно такой. Сирота Гарри Поттер, мальчик с загадочным прошлым в 
настоящее время живет у своих дяди и тети и со своим двоюрдным братом и он даже не 
подозревает что родился в семье магов. Семья его дяди знает об этом, но старается 
скрывать это. Но вот после того как тысячи писем о его приеме к школу Хогвартс 
пришли в дом, но так и не были прочитаны, семья уезжает за город в свой дом на 
острове где к ним приходит великан Хагрид. Он пришел из Хогвартса с целью забрать 
Гарри. И он добивается своей цели, Гарри едет в школу. Там он знакомится с 
некоторыми учениками, а именно с Роном Уизли и Гермионой Грейнджер. После того как 
он попадает в школу, он начинает учиться на одном факультете со своими друзьями. 
 
Я не зря говорю что игра сделана именно по мотивам фильма, а не книги, по которой в 
свою очередь и был сделан фильм. Потому-что именно фильм дал огромную 
популярность сказочному мальчику Гарри Поттеру. Я думаю что такие игры по фильмам 
делались только ради денег. Ну, а если бы Гарри Поттер не был бы популярен - не было 
бы и игр. И то что эта игра была сделана ради денег не чуть не испортило ее. В те 
времена, не то что сейчас, тогда делались добротные игры. А уж особенно на PSX. 
 
Немного только подкачала графика. Но этому есть свои объяснения. Во первых лучше не 
позволяла приставка, а во вторых очень трудно создать красивую, а главно похожую на 
саму себя, модель человека, с текстурой взятой из фильма. И все эти недостатки видны 
не только с экрана эмулятора. Я уже на экране телевизора во время игры заметил как 
неказисто сделаны лица героев. Они словно потеряли что-то. И такая же проблема 
мучает многие другие игры про реальных людей на 32 и 64-битных консолях, например, 
игры серии Tony Hawk's Pro Skater. Но все же в целом игра очень хорошо продумана и 
реализована. Главной чертой этой игры является то, что это не зауряднейшая бродилка, 
как, скажем на SEGA или NES. Игра по фильму про Гарри Поттера должна быть нечто 
больше аркадного платформера с запрыгиванием на головы противникам. Она должна 
быть как минимум логическая с элементами квеста, и т.д. И как раз такая черта была 
учтена при создании игры.  
 
В ней вы, по сути, не должны делать что-то определенное. Вы можете ходить где хотите 
по Хогвартсу, но по мере прохождения разные персонажи вам будут давать указания и 
вы будете просто обязаны их выполнять. И еще по мере прохождения вам будут 
открываться разные двери в разные места замка. Я бы сказал вся игра состоит из 
разных таких мини-игр: изучений уроков, собираний всяких предметов, полетов на 

метле, дуэлей на палочках, сражений с 
разными мелкими, но опасными существами, 
и т.д. Вначале игры эти мини-игры очевидны: 
вам не предстоит ничего больше делать, как в 
них участвовать. Затем они нарастают и вы 
уже не знаете как быть, куда идти. Именно с 
такой проблемой столкнулся я, когда играл в 
эту игру на приставке. Иногда вам придется 
побеждать мини-боссов, таких как Драко 
Малфой, который на протяжении всей игры 
вам будет мешать и вам придется с ним 
сражаться. Но вам встретятся очень много 
таких врагов и многих будет очень трудно 
победить.  
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Также в игре присутствует квиддич. Эта такая игра магов, похожая на баскетболл, но тут 
нужно учавтвовать на метлах. У этой игры очень интересные, и довольно длинные 
правила, но ваше же тут участие ограничевается ловлей снитча и прохождением сквозь 
всякие кольца. Вообще в игре будет очень много полетов на метле. И все они, опять 
таки, ограничиваются одним - прохождением сквозь кольца и прочей ерунды. 
 
Среди призов, которые вы сможете 
собирать, есть разнообразные бобы, 
которые вы должны будете отдавать 
близнецам Уизли, за что они вам окажут 
разные услуги, шоколадные лягушки - 
они вам пополняют здоровье, эликсир - 
это вообще полезная штука, она 
полностью восстанавливает здоровье, а 
также карточки магов. Карточки с магами 
- это своеобразная замена наклейкам и 
вкладышам в школе магов. На них 
изображены самые знаменитые маги, в 
том числе и Альбус Дамблдор. Они имеют 
коллекционную ценность. Собрав хотя бы 
одну вы можете просмотреть информацию 
о этом маге в справочнике. Еще в игре 
присутствуят знаменитые шахматы. Выполнив эти ходы вы завершите шахматные 
уровни: Ходы уровня 1: Белые, Вправо, Влево, Вправо, Влево.  Ходы уровня 2: 
Черные, Вверх-влево, Вниз-вправо, влево. Ходы уровня 3: Белые, Вверх-влево, вверх-
влево, вверх-влево, вниз-вправо, вниз-вправо.  
 
Отличительной чертой геймплея игры является то что все, что происходит в игре - по 
сюжету фильма или книги, а не придуманно создателями. Да, есть моменты, которых нет 
в фильме или в книге, но это лишь для того чтобы было интереснее играть. В целом 
геймплей игры получился так хорошо, что лучше не придумаешь!  
 
 Касаясь графической стороны игры можно только сказать что игра сделана на 
достаточно хорошем уровне и можно понять что происходит на экране. Можно, конечно, 
было сделать и лучше, но не сделали. Хотя современная графика этой игре не сильно 
нужна. Я вообще заметил, что если игра увлекательная, то не важно, какая в ней 
графика, важна только ее увлекательность. А если игра изначально не очень 
интересная, то никакая графика не добавит к ней интерес. Итак, графика в игре 
среднего уровня. 
 
 Музыка в игре довольно приятная и навевает дух волшебства. Тут музыка играет 
большую роль, чем графика, поскольку геймплей игры зачастую строят музыка и видео 
(которое компенсируется "книжными" вставками во время игры). Иногда, в некоторых 
сборниках игр на PlayStation добавляют по несколько игр из одной серии, делая из игр 
продвинутые "рипы", т.е. урезанные игры, в которых нет некоторых мелодий или видео. 
Я удивляюсь! Без музыки в такие игры невозможно играть, создается совсем дугое 
впечатление от игры! Как будто играешь в демо-версию. 
 
 И в залючение я хочу сказать что и сейчас создаются игры про Гарри Поттера, но 
совсем не такие как на PlayStation, они делаются только для компьютера или приставок 
нового поколения. И они совсем не такие как на PlayStation, совсем бездушные... 
  

Блуждал по закоулкам Хогвартса: 
DarkGameWizard farhad95@rambler.ru 
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Улучшаем Windows 

Yod’m 3D 
 
Все вы, вероятно, уже слышали о графических наворотах вышедшей в прошлом году операционной 
системы Windows Vista, а именно — о знаменитом интерфейсе Aero Glass, прилагаемом ко всем версиям, 
кроме Home Basic. Aero дает пользователю интересную возможность осматривать Рабочий стол в 
трехмерном режиме, поворачивая его как заблагорассудится. И, оказывается, существует возможность 
достжения того же в Windows XP.  

Недавно я обнаружил программу со странным названием 
Yod’m 3D. Она создает четыре независимых рабочих стола, 
переключение между которыми осуществляется посредством 
вращения трехмерного куба, каждая из граней которого 
является рабочим столом. Программа даже не требует 
установки — просто распакуйте архив на жесткий диск, 
например, в директорию C:\Yodm3D, и запускайте 
Yodm3D.exe. При первом запуске программа автоматически 
выведет на экран окно настроек, где вы сможете установить 
некоторые предпочтения (горячие клавиши, язык, масштаб, 
эффекты и др.). Разобраться в настройках не составит 
особого труда. Лично мне показалась очень интересной 
возможность активации 3D куба путем наведения курсора 
мыши в угол экрана. По-моему, это гораздо удобнее горячих 
клавиш (которые к тому же можно нажать нечаянно): просто 

предусмотрел уголок там, где часы — туда залезаешь нечасто, так что возможность случайной 
активации исключена — и работай в свое удовольствие. 
Управление кубом интуитивно. Можно нажимать стрелки — правую и левую — для переключения столов 
(при этом стрелки вверх и вниз управляют масштабом куба), или «перетягивать» куб мышью. Вход на 
выбранный рабочий стол осуществляется двумя кликами или нажатием Enter. В настройках можно 
изменить прозрачность граней, так, чтобы можно было видеть столы насквозь.  
И что самое главное, вы можете полностью 
контролировать все четыре стола: открывать на на них 
любые окна и приложения, менять обои, положение 
ярлыков и т.д. Все пользовательские изменения будут 
сохранены, и при следующем запуске Windows, если Yod’m 
3D будет загружен (в настройках есть опция автозапуска), 
вы снова продолжите пользоваться четырьмя 
независимыми рабочими столами. 
Yod’m 3D во время своей работы сворачивается в трей, 
откуда можно получить доступ к контекстному меню. В нем 
можно открыть настройки, узнать информацию о 
программе, или переключиться на любое открытое окно на 
любом из столов. 
Удивительно, что, учитывая все ее достоинства, 
Yod’m 3D распространяется совершенно бесплатно! 
Вы можете скачать дистрибутив (что-то около 1.7 
Мб) на сайте ее разработчика:  
http://chsalmon.club.fr 
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Deskloops 
 
Случалось ли вам путаться в бесконечных дебрях 
открытых окон? Ведь многие любят делать 
несколько дел сразу: печатать текст, слушая 
музыку, в то время как что-то скачивается или 
прожигается диск, причем кроме текстового открыт, 
скажем, графический редактор, калькулятор и 
пара-тройка окон Проводника. Насколько было бы 
удобнее, если существовал способ упорядочить все 
эти окна, чтобы они не налезали друг на друга, 
создавая хаос. И такой способ существует! Конечно, 
можно воспользоваться вышеописанным Yod’m 3D и 
запихнуть музыку с браузером куда-нибудь 
подальше, чтобы не мешались, оставив на активном 
столе  только  то , что  требуется  для 
непосредственной работы, но можно поступить и 
по-другому. А именно, скачать программу Deskloops. 
Deskloops создаст у вас на Рабочем столе упорядоченную систему окон, между которыми вы 
можете перемещатся, как будто они расположены по окружности виртуального цилиндра. 
Цилиндр вращается, показывая вам одно окно за другим. Для пущей убедительности, этот 
самый цилиндр и будет нарисован в центре экрана. 

При первом запуске вы увидите забавный 
анимационный ролик, где талисман программы — Mr. 
Loopster — покажет и расскажет, как пользоваться 
программой. После этого Deskloops вступает в 
действие, и вы сможете перемещаться между окнами, 
просто наведя курсором на правую или левую часть 
экрана. А если навести курсор на самую верхушку 
экрана, выползет красивое меню, где можно увидеть 
в миниатюре все окна. Ими можно управлять, даже 
не открывая — если навести курсор на миниатюру, 
появятся кнопки «Свернуть», «Развернуть» и 
«Закрыть». Еще в меню имеется возможность 
сохранять и загружать так называемые 
«лупы» (loops) - группы открытых окон. Также есть 

настройки, где пользователь может изменить поведение программы под себя, и даже Google-
поиск.  
Во время работы Deskloops прячется в трей, откуда можно открыть руководство или заново 
посмотреть обучающий ролик.  
 
Deskloops распространяется бесплатно, и скачать ее (Верися 2.0 весит около 2 Мб) можно на 
сайте http://www.xilokit.com. 
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LNKRun 
 
С рабочим столом и окнами разобрались, осталась еще одна важная проблема — ссылки к 
программам и документам. Обычно пользователи устанавливают на свои компьютеры десятки, 
если не сотни, различных программ, и практически все из них засоряют меню «Все 
программы» своими ярлыками. Очень скоро ориентироваться в нем становится практически 
невозможно. Но тут приходит на помощь программа LNKRun! Она призвана избавить вас от 
мучений, связанных с поиском нужной программы. В ней вы создаете удобное меню в виде 

дерева папок, в котором можно создавать ярлыки к любым 
файлам на жестком диске. От того же меню «Все программы» 
или Рабочего стола это меню отличается тем, что здесь можно 
создавать группы ярлыков, соответствующих различным темам. 
Если это программы, то можно упорядочить их по назначению: 
графика, текст, мультимедиа, Интернет и т.д. 
Меню располагается в главном окне программы, которое 
сворачивается в трей, таким образом не мешая работе. В 
Опциях можно настроить производительность программы, а 
также выбрать скин. Скинов доступно довольно много, и все 
очень красивые. Есть даже стилизация под Vista, Office 2007 и 
Longhorn. 
 
В общем, для LNKRun найдется место в любом компьютере. Тем 
более, что весит она всего 1.8 Мб. А скачать можно на 
официальном сайте: http://lnkrun.ru. 

Обзор подготовил: 
Gecko clocktower89@mail.ru 

 
 
Эта статья может иметь продолжение, так как разработчики не стоят на месте, выпуская все 
больше новых программ для облегчения работы в Windows. Если вы скачали такую и хотите 
поделиться впечатлениями с читателями FPS, присылайте статью нам на clocktower89@mail.ru. 
Будем только рады ее опубликовать! 



Это все! 
 
Надеемся, номер вышел интересным. Если так, поддержите FPS! Отправляйте статьи, обзоры, 
интервью и прочее на любые темы касательно игр, графики, звука, программрования и т.д. на 
ящик редакции: clocktower89@mail.ru. 
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